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  —  Quick Start
Sequel NetPIM™ is the easiest way to update, manage, and share Web-based information.
Now you can make the most productive use of your online time with Sequel NetPIM—the
world’s first Personal Internet Manager.

Using Sequel NetPIM is easy, and it works with popular Web browsers, such as Netscape
Navigator and Internet Explorer.  This Quick Start guide shows you how to get started filing,
managing, and browsing WWW information, either online or offline.

This Quick Start guide covers the following topics:

• Starting Sequel NetPIM for the first
time

• Setting Up or Modifying an Agent

• Accessing Predefined Bookmarks • Sharing Your Bookmarks by E-Mail

• Importing Your Web Browser’s
Bookmarks

• What IS this Cache Thing?

• Adding a New Bookmark • Even More Features

Hints: (1) As you explore Sequel NetPIM, use your right mouse button to
access shortcuts. Also, when you “click” some of the items on your screen,
your menu options and other possible choices may change.

(2) To learn more about a feature, select it (by clicking it with your mouse)
and use the “F1” key to get online help about that feature.
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(folders with
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See Page 8
for Bookmark
symbols

  Toolbar

Description of
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Right-click on a
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select it and learn
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properties

See page 9 for
a description of
Filter view

“Thumbnail” of Selected Bookmark Site



Sequel NetPIM -- Quick Start

Page 2 Release 1.0

Starting Sequel NetPIM for the First Time

Once you have Sequel NetPIM installed, starting it is easy:

• From the Windows Start menu, select Programs, then select
the Sequel NetPIM folder.  Click Sequel NetPIM to
start the program, or

• Double-click the Sequel NetPIM icon on your desktop
(if you have created a shortcut from Windows).

Accessing a Predefined Bookmark

To help you get started, Sequel NetPIM comes preconfigured with bookmarks for many
popular WWW sites. A bookmark is a collection of information about a specific Web site.
Some Web browsers also refer to bookmarks as “favorites” or “favorite pages.”

1. From the Tree view, double-click a folder to access bookmarks for a topic
that interests you (there may be sub-folders as well). For example,

 Business and Investing  —→  Investors Edge

Click on the plus (+) sign to the left of a folder to open it; click on the minus
(-) sign to close it.

2. Double-click a bookmark to view the selected Web site in your browser.

You must have a Web browser already installed and configured on your
computer.

Importing Your Web Browser’s Bookmarks

You can also import your collection of bookmarks from your default Web browser.  (You may
have more than one Web browser on your computer, but only one of them is the default.)

1. Select the Tree view, and select the Web Address Store folder. Once you
import your Web browser’s bookmarks, these bookmarks and the folders
they are in will appear under the Web Address Store folder.

2. From the File menu, click Import Browser Bookmarks.  Note: Any
duplicate bookmarks will not be imported.

3. To configure Sequel NetPIM’s features for an imported bookmark, select a
bookmark by right-clicking on it; select Properties, and then edit the
properties as described in the next section.
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Adding a New Bookmark

To add a new bookmark:

1. Start your Web browser, for example, Netscape Navigator (version 2.0 or
newer) or Microsoft Internet Explorer (version 2.0 or newer).

2. Using your Web browser, go to the Web site that you want to bookmark.

3. From the Sequel NetPIM File menu, select New Bookmark.

 

4. Select the Get From Browser button to automatically add the Web page
name, the current URL (Web page address), and thumbnail to your new
bookmark.

5. Enter your preferences for the following information.  For the General tab:

• Description — Enter text that can help you track this bookmark later.
All of this bookmark information is available when you right-click any
bookmark (and select Properties).

• Cache Options — To enable offline viewing of a Web site, select as
much of the information as you would like to view offline.  Cache
Nothing — no offline viewing; Cache Text Files Only — permits
offline viewing of text but not graphics (pictures); Cache All Files —
offline viewing of both text and graphics.

 Stay on Site — Only cache text and graphics local to the Web site being
bookmarked.  That is, do not cache information linked to other Web sites.

 Levels to copy to local storage — Select the number of levels of pages from this
site to be cached, from 1 to 5.
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Note that the more levels you select, the more hard disk space that
will be used for storing your information.

• Thumbnail — Capture a snapshot (small picture) of the page currently
visible in your Web browser.  Clear allows you to delete the snapshot.

• Security — To access detailed articles on some Web sites, you must
first register.  In order for Sequel NetPIM to access those sites for you,
you must enter the User Name and Password with which you
registered at each Web site.  For example, a subscription to the Wall
Street Journal requires registration.

1. To configure Sequel NetPIM so that it automatically retrieves and updates
information from the Web site, select the Agent tab.

Refer to the next section for more information about Agents, including how to
configure a new Agent or to modify or delete an existing one.

• Select the name of the Agent that you wish to associate with this
bookmark, then click OK. Once you select the Agent name in the
Bookmark Agent window, information about the Agent appears in the
Agent Description field below it (that is, the dates and times the Agent
runs).

Setting Up or Modifying an Agent

Agents are the part of Sequel NetPIM that automatically retrieve the latest information from
the Web for you. This is especially useful, for example, if you are using a dial-up, Internet
Service Provider (ISP). When you dial up your ISP, it may be busy at the time you want to
view Internet information, or you may want to save time by having the information ready for
you. Sequel NetPIM gives you the ability to download this information in advance, and view it
later at a time convenient for you.

Also see page 11, Agent Manager, for more information about monitoring and
managing your Agents.

Once you have configured an Agent, you can associate it with as many bookmarks as you like.
Remember that for a specific Agent, the following settings apply to all bookmarks that use it.

To set up a new Agent or modify an existing one:

1. From the Sequel NetPIM Tools menu, select Agents.

2. From the Agent List window:

• To modify an existing Agent: select (highlight) the Agent you want to
modify and then select the Properties button, or

• To create a new Agent: click the New button.

3. On the General panel, configure the following:

• If this is a new Agent, enter a name.
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• Enabled — Select this checkbox to allow this Agent to run at the
configured days and times.

• How Much — Select the maximum running time (in minutes) and the
maximum disk space (in megabytes) values.

4. Select the Schedule tab.

5. On the Schedule panel, configure the following:

• Overall Frequency — Select how often you want this Agent to run.
Note that for most options, once you select an option, more options are
available to the right.

• Daily Frequency — Select either the hour the Agent runs, once per day,
or else how often the Agent runs during a day (in hours or minutes).

• Starting and ending times, as well as the Start Date, can also be
configured.

6. Click OK to finish.

Remember: You associate an Agent with a bookmark using the bookmark’s
properties.  Right-click a bookmark to access its properties. See the end of
the previous section for more information.

Share Your Bookmarks by E-Mail

You can share your Bookmarks and cached information with other Sequel NetPIM users.

Your e-mail program must be MAPI compliant; for example, Microsoft
Mail, Microsoft Exchange, or QUALCOMM Eudora 3.0.

Sending Bookmark Information

1. From the Sequel NetPIM Tree view, select a bookmark.

2. Right-click the bookmark and click Send.

3. When prompted, answer yes if you want cached information to be included
as part of the e-mail message.  Cached information includes any text and
pictures that you have collected for this bookmark.

Caching must have been previously configured for this bookmark, or else
these text and picture files do not exist on your computer.

4. Once the Sequel NetPIM information has been prepared, your default e-mail
program is started.  Complete the information in your e-mail program, and
send the message.
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Receiving Bookmark Information
When you receive a bookmark in e-mail from another Sequel NetPIM user:

1. Open the e-mail message in your e-mail program, and double-click on the
attachment (the bookmark information).

2. If Sequel NetPIM is not running, it will be started.

3. The bookmark is added as a highlighted entry in the Tree view within the
Web Address Store (individual bookmarks are listed after the folders).  If
you already have this bookmark, you will be asked if you want to replace it.

What IS This Cache Thing?

The Sequel NetPIM cache (storage area of your hard disk) is the key to the offline viewing of
new or updated Internet information for your bookmarks. The text and pictures of the Web
pages that you view are placed in this cache, so that you can access them when you want to.
(You can define the cache properties for each bookmark.)

The size of the cache is limited by the amount of available free, hard disk space on your
computer as well as options that you can configure within Sequel NetPIM.  Configuring this
information is discussed in the following steps.

The basic information about a Web site (bookmark, address (URL), description,
and thumbnail) are not part of the cache and are not affected by cache
operations.

By default, the Sequel NetPIM cache uses half of your hard disk free space, not to exceed 100
MB.  To change these settings:

1. From the Sequel NetPIM Tools menu, select Options.

Size of disk free
space plus
Sequel NetPIM
cache

Total size of
hard disk or
partition
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2. On the Cache Management panel, configure the following:

• No Limit — The cache will use as much hard disk free space as is
needed.  In the example, up to 1023 MB is available.  Normally, you
would not allocate all of this space, since other programs will probably
need to use it.  The above example allocates 500 MB for cache.

• No More than [    ]  MB — Specify the maximum amount of hard disk
free space that can be used for cache.  The example specifies to use no
more than the default value of 100 MB.

• Action — What you want done when the allocated cache size has been
exceeded (that is, when there is not enough available hard disk space
for the Internet information that you want to add):

• Remove oldest unused files until cache is below limit  —  Sequel
NetPIM removes the oldest bookmark files first (text and graphics,
but not the basic bookmark information).

• Remove bookmark caches that haven’t been looked at in [   ]  days
—  Sequel NetPIM checks the time stamp of the bookmarks, and
removes those that haven’t been accessed in the number of days
that you specify.

• A graphic representation of your hard disk and cache.

• The left side of the graph (a blue area, often thin when Sequel
NetPIM is first installed) —  The amount of hard disk space
currently used by the Sequel NetPIM cache.  Its size (in megabytes)
is indicated by the number you selected previously—either “No
Limit” or “No more than [   ]”.

• The area toward the middle of the graph (often with a gray
background, depending on your screen colors) —  The amount of
hard disk space that is not being used currently.  Its size (in
megabytes) is indicated by the number at the left end of the red bar.
Often called disk “free space,” this is the amount of space available
for Sequel NetPIM cache.

• Bar (red line or bar) at right —  The amount of disk space that is
not available to the cache.  This hard disk area is already being
used for other purposes (other programs, documents, and so forth).

• Vertical, yellow line —  The Sequel NetPIM cache limit.  This line
indicates how your cache limit relates to your hard disk free space
and the amount of disk space already used.

Remember: You can configure exactly what to cache for each bookmark:
nothing, text only, or all (text and graphics). Select a bookmark, then right-
click to access and configure the bookmark’s properties.
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Bookmark Symbols
There are several symbols for bookmarks that let you see, at a glance, important information
about that bookmark (that is, the entry for a Web site in Sequel NetPIM).

Symbol Description

The basic symbol for a bookmark.

A red starburst indicates that bookmark has new information that you haven’t
viewed (either a new bookmark or one that has been updated).

 The diskette symbol indicates that you have configured this bookmark to
maintain cached information (text and graphics, if you selected one or both of
these properties).

Both the starburst and the diskette symbols appear when you have both new
information and cached information for the bookmark.

A red X indicates that you had attempted to update information for a bookmark
(either directly from the File menu or the toolbar button, or through a
scheduled agent) but the update failed.  This symbol only occurs in the Agent
Status column of the Filter view (not in the Status column).
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Even More Features

There are many more features and options available to you with Sequel NetPIM that help you
access and manage information from the Internet (the Web), including the following.

Filter View
Filter view is the second of the two main window views of Sequel NetPIM.  It displays all of
your bookmarks alphabetically and without folders, and it gives you the ability to sort and
manage your bookmarks in various predefined ways. It also displays the summary information
for the bookmarks in an easy-to-read format. To see all of these column headings, you will
probably need to widen your view of Sequel NetPIM. (To see all of the column headings,
double-click in the title bar of your Sequel NetPIM window.)

The detailed information for the bookmarks (that is, the column headings) changes, depending
on the predefined filter that you choose.

The predefined filters include the following:

• All Bookmarks —  An alphabetical list of all of your bookmarks. This filter
helps you locate a bookmark within a folder in the Tree view.  Select a
bookmark and click the Locate in Tree button to locate the bookmark in the
Tree view.

• Updated Bookmarks —  Bookmarks that have received new information
since the last time you viewed them (including new as well as updated
bookmarks). These bookmarks have a red starburst symbol on them.

Title Bar

Locate in Tree
button

Filtered
Bookmarks
listed in
alphabetical
order

List of
Filters

Information for Filter
view is context
sensitive (the
headings and their
order change).
Maximize width to
see all column
headings.
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• Cached Bookmarks — All bookmarks that have cached information. These
bookmarks have a diskette symbol on them.

• Bookmarks With Agents —  All bookmarks that have Agents scheduled for
them.

• Bookmarks With Failed Downloads —  Use your maximize button or drag
the right side of the Sequel NetPIM window to see all of the Filter view
columns.  The Failed Download icon (with the red X) appears in the Agent
Status column (not in the Status column).

Internet Connection
You need to configure Sequel NetPIM for one of two types of Internet connection.

• In many businesses and similar organizations, you can connect to the
Internet with a network.

• If you are using a PPP or SLIP direct dial up account with a modem, you
can configure Sequel NetPIM so that Internet information can be collected
for you when you are away from your computer.

To use a dial-up connection (modem), you must have already configured your
ISP information in Windows. Refer to your Windows (95 or NT 4.0) user
documentation or online help.  Windows online help is available from the
Windows Start menu.

To configure Sequel NetPIM to use a network (usually through wiring in the workplace):

1. From the Sequel NetPIM Tools menu, select Options.

2. Click on the Internet Connection tab, if it is not in the foreground.
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3. Select Connect through network.

4. Click OK to finish.

To configure Sequel NetPIM to use a modem and an Internet Service Provider (ISP):

1. From the Sequel NetPIM Tools menu, select Options.

2. Click on the Internet Connection tab, if it is not in the foreground.

3. Select Connect through dial-up.

4. Select your Dial-Up Internet Connection.

 In the previous example, MyDialUpServer is the name given to the Internet
connection configured from Windows.

Note: If no name appears in the box and you cannot select any, you do not
have a dial-up connection set up in Windows.  See the instructions at the
end of these steps.

5. Enter your User Name and Password (from your Internet provider).

6. Click OK to finish.

For further information about configuring your Dial-Up Connection or your Modem, refer to
the Windows 95 (or Windows NT 4.0) online help.  Click your Windows Start button (usually
in the lower left corner of your screen), and select Help.  Click on the Index tab, and search
for “Dial-up Networking,” “Internet Connection,” “Modem,” etc.

Print
You can print a summary sheet for each bookmark. The summary sheet includes the
information from the bookmark’s properties window, including the thumbnail, Agent (if any),
and related activity and cache information.

1. Select the bookmark for which you would like a summary (by clicking it
with your mouse).

2. From the Sequel NetPIM Files menu, select Print Bookmark Summary.

Agent Manager
When you have Agent Manager running, a red “alarm clock” icon appears in the status area of
the taskbar (this area is usually at the bottom right of your screen, unless you customized this
Windows feature). When one or more Agents are collecting information from the Internet for
you, the red alarm clock also includes a blinking diskette symbol.

To monitor the status of the Agent(s) that are collecting information:

1. Right-click on the Agent icon that is in your taskbar.

2. Select Status.
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The Sequel NetPIM Agent Manager window is displayed and lists all bookmarks that have
Agents running, as well as their URLs, and the status of the Agent (either “running” or
“terminating”).

• To stop a bookmark from being updated, select the name of the bookmark
and click the Terminate Update button. Click the Close button when you
are finished.

Icon Description

Agent Manager is installed, but no Agents are collecting information from
the Internet at the moment.

If, during installation, you had Sequel NetPIM Agent Manager added to the
Startup group, this symbol will appear in the status area of your Windows
95 (or Windows NT 4.0) taskbar every time you start your computer.

One or more Agents are downloading information from the Internet (that is,
adding Internet information to the cache for later viewing).

One or more Agents are updating bookmark information from the Internet
(new information for the Properties of a bookmark).

Two or more Agents are collecting information from the Internet.  At a
minimum, one is downloading files and one is updating information—see
previous two symbols (also see the basic Bookmark properties).

Agent Manager is purging files from the cache (for more information , see
the Tools menu, select Options, and then click the Cache Management
tab).

Agent Manager is using a dial-up connection (telephone line) to collect
information from the Internet.


